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Copyright Notice

Copyright © 1998 Magellan Corporation. All rights reserved.  

No part of this publication or the computer programs described in it may be 
reproduced, translated, stored in a retrieval system, or transmitted in any form o
any means, electronic, mechanical photocopying, recording, or otherwise, witho
prior written permission of Magellan. Your rights with regard to this publication a
the computer programs are subject to the restrictions and limitations imposed by
copyright laws of the United States of America (“U.S.A.”) and/or the jurisdiction i
which you are located.  

For information on translations and distribution outside the U.S.A. please contac
Ashtech.

Printed in the United States of America.

Part Number: 630063, Revision D

December 1997

Trademark Notice

Evaluate is a trademark of Magellan Corp.  All other product and brand names a
trademarks or registered trademarks of their respective holders.
Evaluate 5.0 User’s Guide



se 
ge 
it and 
 the 
press-

ram 
nd all 
e by 
g 
crets 
 to 

y 

ss 
 may 

erated 
bureau 
rwise 
ior 

pile, 
 or any 

 

 copies 

of the 
nd 
ods.
SOFTWARE LICENSE AGREEMENT

IMPORTANT: BY OPENING THE SEALED DISK PACKAGE CONTAINING THE SOFTWARE 
MEDIA, YOU ARE AGREEING TO BE BOUND BY THE TERMS AND CONDITIONS OF THE 
LICENSE AGREEMENT (“AGREEMENT”).  THIS AGREEMENT CONSTITUTES THE COM-
PLETE AGREEMENT BETWEEN YOU (“LICENSEE”) AND MAGELLAN CORPORATION 
(“LICENSOR”).  CAREFULLY READ THE AGREEMENT AND IF YOU DO NOT AGREE 
WITH THE TERMS, RETURN THIS UNOPENED DISK PACKAGE AND THE ACCOMPANY-
ING ITEMS TO THE PLACE WHERE YOU OBTAINED THEM FOR A FULL REFUND.

LICENSE.  LICENSOR grants to you a limited, non-exclusive, non-transferable, personal licen
(“License”) to (i) install and operate the copy of the computer program contained in this packa
(“Program”) in machine acceptable form only on a single computer (one central processing un
associated monitor and keyboard) and (ii) make one archival copy of the Program for use with
same computer.  LICENSOR and its third-party suppliers retain all rights to the Program not ex
ly granted in this Agreement.

OWNERSHIP OF PROGRAMS AND COPIES.  This License is not a sale of the original Prog
or any copies.  LICENSOR and its third-party suppliers retain the ownership of the Program a
copyrights and other proprietary rights therein, and all subsequent copies of the Program mad
you, regardless of the form in which the copies may exist.  The Program and the accompanyin
manuals (“Documentation”) are copyrighted works of authorship and contain valuable trade se
and confidential information proprietary to LICENSOR and its third-party suppliers.  You agree
exercise reasonable efforts to protect the proprietary interests of LICENSOR and its third-part
suppliers in the Program and Documentation and maintain them in strict confidence.

USER RESTRICTIONS.  The Program is provided for use in your internal commercial busine
operations and must remain at all times upon a single computer owned or leased by you.  You
physically transfer the Program from one computer to another provided that the Program is op
only on one computer at a time.  You may not operate the Program in a time-sharing or service 
operation or rent, lease, sublease, sell, assign, pledge, transfer, transmit electronically or othe
dispose of the Program or Documentation, on a temporary or permanent basis, without the pr
written consent of LICENSOR.  You agree not to translate, modify, adapt, disassemble, decom
or reverse engineer the Program, or create derivative works of the Program or Documentation
portion thereof.

TERMINATION.  The License is effective until terminated.  The License will terminate without
notice from LICENSOR if you fail to comply with any provisions of this Agreement.  Upon 
termination, you must cease all use of the Program and Documentation and return tem, and any
thereof, to LICENSOR.

GENERAL.  This Agreement shall be governed by and construed in accordance with the Laws 
State of California and the United States without regard to conflict of laws provisions thereof a
without regard to the United Nations Convention on Contracts for the International Sale of Go
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Description

The Ashtech Evaluate software provides system integrators and end users with a quick 
and simple way to interface with an Ashtech OEM board or sensor product in order to 
gauge performance and develop an integrated system. Evaluate allows for easy connection 
to each product and provides a suite of features to view, log, and analyze performance. 
These features include:

• Support for Ashtech receivers and non-Ashtech receivers that utilize standa
NMEA responses 

• Convenient Position Information window that indicates real-time accuracy, 
charts receiver position, and graphically displays horizontal speed, vertical 
speed, altitude, and heading. Pitch, roll, and yaw are also displayed for Asht
ADU2 receiver.

• Tabular summary of lat/lon position, altitude above WGS-84, UTC time, DGP
status, number of SVs used in position calculation, and HDOP, VDOP, PDO
TDOP 

• Easy-to-use satellite Sky Chart window that charts satellite location in the sky,
identifies satellites by number, indicates which satellites are being used in th
receiver calculation, and displays relative satellite signal strength

• Facility to download an almanac from Ashtech receivers. Almanacs are 
compatible with Ashtech’s Mission Planning software.

• Data logging functionality that supports data replay for later analysis using th
full Evaluate feature set

• Automatic communication programs and pre-defined command sets
• Simple terminal program that gives you the option to open a terminal screen

communicate with the receiver by sending preset command strings, user-de
command strings, or individual set or query commands. All responses can b
viewed from the terminal screen 

• Print capability that allows you to print a specific window or the entire screen
aluate  1
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Products Supported

Evaluate supports the following Ashtech products:

• ADU2
• GG24
• G12
• G8
• Sensor II
• Super C/A
• Z12, Z-Surveyor, Z-Sensor, and Z-Eurocard

Evaluate also supports any other receiver that output data in standard NMEA for

Installation

Perform the following steps to install the Evaluate software:

We recommend you run this program on a 486/66 machine or better.

1. Start Microsoft Windows 3.x, Windows 95, or Windows NT.

2. Close all open applications.

3. Insert the Evaluate installation disk in your floppy drive.

4. Select File from the Program Menu to activate the drop-down menu.

5. Select Run.

In the Command Line, type: A:\SETUP or B:\SETUP depending on which 
floppy drive you use for installation.

 If you have a previous version of Evaluate installed in the target directory, you must remove the 
older version with “Uninstall Evaluate.”

6. The Evaluate Setup program guides you through the remainder of the 
installation procedure.
Evaluate 5.0 User’s Guide
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Operation

1. To ensure proper operation, and before using the Ashtech Evaluate 
commands, verify the GPS receiver is:

• Turned on
• Properly connected to your computer (most require a null modem 

cable).

If you have the Ashtech Evaluation Kit, the cable is ready to be plugg
directly into your computer.

2. Double-click the Evaluate icon.

The Evaluate Startup menu opens, as shown in Figure 1.      

3. Select one of the menu options by selecting the radio button to the left o
selection you have chosen.

A “radio button” is the small round icon (in a Windows Graphical User Interface) used to select 
different options.

 Figure 1:  Evaluate Startup Menu
aluate  3
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4. Click OK to begin session.

Emulation

Evaluate contains a program which emulates a GPS receiver so that you can observe 
how the most common features of Evaluate work without needing a receiver 
connected.  It is designed as a demonstration module only.  To activate, select 
Emulation in the GPS menu or select Emulation from the Ashtech Evaluate 
Startup menu. Evaluate must be disconnected from all GPS receivers for Emulation 
mode to work.

The emulation mode is designed to provide a wide range of positions,  velocities, and satellite 
parameters. While this feature demonstrates how the position and Sky chart screens work, it does 
not represent actual GPS data.

Table 1: Startup Menu Options

Option Description

Connect to GPS Receiver The Connection Parameters window opens allowing 
connection to a GPS receiver. Refer to “Connecting to an 
Ashtech GPS Receiver” on page 5. If you run Evaluate for the 
first time, Evaluate sets this option as the default.

Connect to GPS Receiver 
with last settings

If Evaluate has been run and closed without disconnecting the 
GPS receiver, Evaluate sets this option as the default.
This option allows you to start initialization of a GPS receiver 
with the settings of the previous session. On running Evaluate 
for the first time, the Connection Parameters window appears.

View log file Evaluate will open the Open dialog box. Refer to “Viewing a 
Log File” on page 20.

Emulation Evaluate activates emulation mode. Refer to “Emulation” on 
page 4.

Info about Ashtech GPS 
Receivers supported by 
Evaluate

Evaluate opens an information window describing products 
supported by the software.

Display this menu on startup Uncheck this box if you no longer wish to see it displayed.

Activate Analysis Refer to “Using Evaluate for Analysis” on page 22.

Cancel Closes startup menu without loading options.

Help Launches Help module.

OK Launches Evaluate with the option selected.
Evaluate 5.0 User’s Guide
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Connecting to an Ashtech GPS Receiver

1. Selecting the Connect to a GPS Receiver option automatically opens the 
Connections Parameters window. You can also access this window by  
selecting GPS from the main menu to activate the drop-down menu (Figure 
2), and then selecting Connect from the drop-down menu.     

 When you open the Evaluate application the first time, the CONNECT selection of the GPS menu is 
selected by default.

2. If it has not been done by default, select Connect from the drop-down menu 
to open the Connection Parameters window (Figure 3).  Depending upon 
configuration, your system may list as many as 4 ports, COM1 up to COM4.  
   

The button DIFF_BAS.GPS is inactive in this context.

 Figure 2:  GPS Drop-down Menu

 Figure 3:  Connection Parameters Window
aluate  5
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3. Click the drop-down arrow and select the communication port connected to 
the receiver as indicated in Figure 4 (COM2 is shown, your setup may be 
different).          

4. Click Port Setup (in the Connection Parameters window) to view the 
following settings (Figure 5): 

• Baud rate
• data bits
• parity
• stop bit    

5. Click the drop-down arrow of any of these settings and select a new setti
a change is necessary.

6. Click OK when all the settings are as desired. Evaluate closes the COM 
Port Setting window and returns to the Connection Parameters window.

The Evaluate default communication parameters are set to the following:  9600 baud, 8 data bits, no 
parity checking, 1 stop bit.   The default communication parameters for your receiver may be 

 Figure 4:  Connection Parameters Window with COM2 Selected

 Figure 5:  COMx Port Settings Window
Evaluate 5.0 User’s Guide
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different.  Refer to the reference manual for your receiver to determine default communication 
parameters.   If you are running Evaluate on the WindowsNT or 95 operating system, the maximum 
baud rate is 57,600.

If you have been experimenting with different connection parameters to connect to the receiver, but 
would like to return to default parameters, simply select the DEFAULT COM SETTING option in the 
CONNECTION PARAMETERS screen. 

7. Check the box Turn off ALL NMEA messages on detach in the 
Connection Parameters window to automatically disable any enabled 
NMEA messages when you disconnect or exit from Evaluate. 

8. You are now ready to connect to the receiver.  Click Connect to start 
initialization. The Initialization of GPS window opens, as shown in     
Figure 6.  Evaluate automatically attempts to communicate using the settings 
you have chosen.  If it does not connect immedately, Evaluate may be set to 
different communication parameters than the receiver.  If this is the case, a 
dialog box appears asking you if you want to try Autoselect (for Ashtech 
receivers) or Manual Connect (for non-Ashtech receivers).  For non-
Ashtech receivers, refer to page 42. For Ashtech receivers, you should 
choose Autoselect by clicking on Autoselect.   When you choose 
Autoselect,  Evaluate tries different baud rates with different parameters 
until it connects successfully.  When a successful connection is made, a 
dialog box appears that identifies the receiver parameters for future 
reference.  Click OK to continue. Evaluate connects and issues three 
commands: 

• PWR (power) set command
• PRT (port) query
• RID (receiver identification) query

Your receiver responds accordingly.  Click OK, and the initialization 
window disappears.  You are now ready to continue communication with
receiver, or open windows to analyze the data from your receiver. 
aluate  7
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Table 2 describes the components of this window.

Connecting to an Ashtech GPS Receiver Using a Cus-
tom *.GPS File

The Initialize From File option in the Connection Parameters window allows you 
to customize the receiver initialization process. If you mark this box, commands from 
the *.GPS file (user-selectable) are used to initialize Evaluate.  For information about 
creating or editing a .GPS file, see “Creating a *.GPS file” on page 21.
You can use the “connect” function at any time to initialize the receiver with a *.GPS file even if you 
are currently connected to the receiver.

 Figure 6:  Initialization of GPS Window

Table 2: Initialization of GPS

Component Description

Text within window Rows beginning with “S” are the send commands. 
Row beginning with “R” are the responses.

AutoSelect Automatically determines the RS-232 
communication parameters of a GPS receiver by 
sending $PASHQ, PRT with different parameters 
of the port.

Stop Allows you to stop and select any command in the 
window.

<<, >> Scrolls through the commands.

Cancel Terminates initialization.
Evaluate 5.0 User’s Guide
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Disconnecting from a GPS Receiver

Once Evaluate is connected to the GPS receiver, the Disconnect option is available in 
the GPS menu. To disconnect the receiver, simply select Disconnect. The 
Disconnect option is especially useful for viewing a log file. Evaluate must be 
disconnected from the receiver to view log files.  There may be a short delay in your 
ability to move the cursor while your computer disconnects from the receiver. 

Sending Commands to the GPS Receiver

Evaluate provides the user with three methods to send set and query commands to the 
receiver. Two of the methods can be accomplished from the GPS Receiver Terminal 
window, and the third method from the menu of commands under GPS in the main 
toolbar.

Using *.GPS files also sends commands to the receiver, but only during receiver initialization. 

Method 1

1. Select Terminal from the GPS menu. The GPS Receiver Terminal 
window opens, as shown in Figure 7.     

2. Click the Menu radio button.

 Figure 7:  GPS Receiver Terminal window
aluate  9
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3. Select a command from the list of predefined commands in the command 
line field (Figure 8).      

The predefined commands are contained within the *.MNU files in the 
directory where Evaluate was installed (usually C:\EVALUATE). Evaluate 
allows you to customize this menu for your particular needs. You can edit 
these files with any text editor to add or delete commands. For additional 
information refer to “MNU File Type” on page 33.

4. Select the desired command, then click Send.  You will see the command 
sent (blue text) and the acknowledgement or response (green text).  So
commands will ask for additional information after you click Send.  In these 
cases, select the information from the options chosen, and click Send again. 

Evaluate 5.0 supports a wide range of receivers, each with a potential variety of options.  Some of the 
commands listed here may not work if you do not have the appropriate options loaded on your 
receiver.  Consult the user manual for your particular receiver. 

 Figure 8:  GPS Receiver Terminal Pre-defined List of Commands
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Method 2

1. Select Terminal from the GPS menu. The GPS Receiver Terminal 
window opens (refer to Figure 7).

2. Click the Type radio button.

3. Type in the command you wish to send and click Send.

The terminal screen will echo what you typed in blue text, followed by the 
receiver response (usually an information string or an acknowledgment) in 
green text. Evaluate retains a limited history of commands you enter. Click 
on the down arrow at the far right side to the screen to view the command 
history (Figure 9). 

4. An invalid Set command will receive a NAK response.       

Method 3

1. Select Send from the GPS menu. The Menu of commands for GPS 
window opens Figure 10).   

 Figure 9:  History of User-entered Commands

 Figure 10:  Menu of Commands for GPS Window
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2. The menu of commands for GPS window contains pre-defined commands, 
as shown in Figure 11.     

3. Choose a command, then select Send.  The command is sent, but this screen 
provides no positive confirmation of command activity.  To view the results 
of your command, simply open the GPS Receiver Terminal window to 
view activity. 

Opening the Port Activity window

The Port Activity window indicates whether the receiver is operational and which 
port is in use. Select the Port Activity command from the View menu. (Figure 12).         

Blinking colors in the R or S columns mean the program records receiver responses 
or the program sends commands to the receiver.

Using Position Information Window to Display Position 

The Position information window provides real-time graphic display of basic GPS 
information. This is one of the most commonly used windows for Evaluate users. 

 Figure 11:  Menu of Commands for GPS Window with List

 Figure 12:  Port Activity Window
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To open this window, select Position from the View menu, or simply click on the 
Position icon on the tool bar. The window, Figure 13,  is divided into three panes: 
Departure Plot, analog dials, and GPS information. 

For Ashtech receivers: once you have selected Position, Evaluate automatically sends 
POS (position) and SAT (satellite) set commands to the Ashtech receiver.  The 
receiver returns POS and SAT responses for display of position information;  the 
receiver continues to output POS and SAT responses (even if you close the window) 
until instructed to stop.  Selecting Disconnect from the GPS menu does this 
automatically, or you can instruct the receiver from the GPS Receiver terminal 
window.

For non-Ashtech receivers, you must set up the receiver to output the NMEA 
messages GGA, VTG, GSA, and GSV or as many of these as the receiver supports.

Then open the Position window. If you close this window and reopen it later,  
positions are displayed, beginning from the time you reopened the window.  Data 
from the previous viewing session are no longer displayed.      

Departure Plot

The Departure plot displays real-time graphic plotting of the current position relative 
to the starting point. The concentric circles are automatically scaled and allow for 
quick determination of the distance from the starting point. The scale of the circles 

 Figure 13:  Position Information Window
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can be manually adjusted using the Home and End keys.  The default units are 
meters.  The units, as well as other features of the plot (color, background, etc.) can be 
adjusted by selecting Options under the View menu, as described in “Colors” on 
page 41.

Analog Dials

Six analog dials and digital displays provide information on the following:

• horizontal speed
• vertical speed
• course/heading
• altitude
• yaw/pitch
• pitch/roll

The dials are set to standard aeronautical design as a default setting. You can c
the look of these dials from the Options selection under the View menu, as described 
in “Colors” on page 41.   Evaluate determines the maximum value for each dial 
depending on the current value.

Evaluate grays out the Yaw/Pitch and Pitch/Roll dials for all receivers except the
ADU2. Table 3 describes the course heading, yaw/pitch, and pitch/roll dials.

The measurement units of all available values are set with Options command from the View menu.

Table 3: Analog Dials Description

Dial Description

Course/Heading Displays a vehicle heading and course-over-ground (COG). The 
white arrow points in the direction of the COG. The vehicle 
figure points toward the heading. The difference between the two 
is the Yaw heading.

Yaw/Pitch • Yaw angle displayed by the red arrow. The range of the yaw 
angle is ±30°. The yaw angle is positive when the vehicle 
yaws clockwise.

• The pitch angle of the vehicle is displayed by the green arrow 
on the dial and by the distance between the first of the 
parallel lines that represent the horizon and the fixed vehicle 
line on the Pitch/Roll dial. The distance between these line is 
10°. The range of the pitch angle is ±60°.

Pitch/Roll • The roll angle is displayed by the angle between the rotating 
graduated vertical axis and the fixed vehicle line on the dial.

• The range of the pitch angle is ±90°.
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Information Summary

Below the departure plot and the analog dials is an information summary for the 
current position. Table 4 describes each field in the information summary:

Using Sky Chart Window to Display Satellite Information

The Sky Chart window, Figure 14, provides detailed information regarding the 
satellite constellation. This is another commonly used window in Evaluate.  You can 
open the Sky Chart window by selecting Sky chart from the View menu, or simply 
selecting the Sky Chart icon on the tool bar. 

For Ashtech receivers: when you open Sky Chart, Evaluate automatically sends POS 
(position) and SAT (satellite) set commands to the receiver.  The receiver then returns 
POS and SAT responses for display of satellite information.  Closing the window 
ends the display of satellite information, but the receiver continues to output POS and 
SAT information until instructed to stop.  Selecting Disconnect from the GPS menu 
does this automatically, or you can instruct the receiver from the GPS Receiver 
Terminal window.

For non-Ashtech receivers, you must set up the receiver to output the NMEA 
messages GGA, VTG, GSA, and GSV or as many of these as the receiver supports.

Table 4: Satellite Position Information

Pane line Description

Autonomous/differential GPS 
position or GPS+GLONASS for 
GG24)

• Autonomous GPS position—position is not 
differentially corrected

• Differential GPS position—position is differentially 
corrected with RTCM format corrections

Number SVs used in position fix Number of satellites used in position fix

UTC time Current Universal Coordinated Time

Latitude Latitude component of position.

Longitude Longitude component of position.

Altitude above WGS-84 Altitude above the WGS-84 ellipsoid.

PDOP Position Dilution of Precision.

HDOP Horizontal Dilution of Precision.

VDOP Vertical Dilution of Precision.

TDOP Time Dilution of Precision.

Double differences (ADU2 Only) Double differences for baselines 1 (1-2), 2 (1-3), 3 (1-4)

BRMS (ADU2 only) Measurement of the baseline residuals

MRMS (ADU2 only) Measurement of the measurement residuals
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The window  is divided into a polar plot and an information summary.  Information in 
the window is delineated by color for ease of viewing.

Polar Plot

The polar plot graphically displays the position of satellites in the sky. There are three 
concentric circles representing elevations above the horizon. The outermost circle 
represents 0 degrees above the horizon, the next circle in represents 30 degrees above 
the horizon, and the smallest circle represents 60 degrees above the horizon. The 
center of the circle represents 90 degrees above the horizon. The line at the top of the 
circle points north with west on the left side of the circle.

Information Summary

To the right of the polar plot is an information summary of the current satellite 
constellation. Table 5 describes each field.

 Figure 14:  Sky Chart Window

Table 5: Satellite Information Summary

Symbol Field Description

Ch Channel Shows total number of receiver channels being used

N SV number PRN number of satellite

A Azimuth Satellite azimuth angle

E Elevation Satellite elevation angle in degrees

SN SN ratio Signal-to-noise ratio for satellite. Scaled from 0 
(weakest) to 99 (strongest), or in dB/Hz depending on 
receiver setup.

U or - Used in position 
computation

Whether or not satellite is being used in position 
computation:

• “U” indicates used
• “-” indicates not used
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The symbol column applies only when Sky Chart has been selected for display in a vertical 
orientation. 

If you have connected an ADU2 (or Emulation is active), Evaluate also displays the  
summary shown in Table 6.      

Epoch Counter

Evaluate has an epoch counter to keep track of the number of epochs recorded in the 
current file. When file logging is in progress, the Epoch counter window, Figure 15, 
can be opened by selecting Epoch Counter from the View menu, or simply by 
clicking on the Epoch Counter icon on the tool bar.      

While the epoch counter is most commonly used for file logging, the Epoch counter 
window can also be opened when the Position information or Sky chart screens are 
opened.The epoch counter begins counting epochs from the instant the Position 
information or Sky chart screens open. After both of these screens close, the epoch 
counter resets to zero and disappears (unless there is an active log session). If you 
close the Epoch counter window while these screens are still open, the epoch counter 
continues counting until the screens are closed. 

Table 6: Satellite Information—Additional Fields

Field Description

Ant1 SV Number Satellites being tracked on antenna 1.

SNRratio Signal-to-noise ratio for antenna 1.

Ant2 SV Number Satellites being tracked on antenna 2.

SN Ratio Signal-to-noise ratio for antenna 2.

Ant3 SV Nmber Satellites being tracked on antenna 3.

SN RAtio Signal-to-noise natio for antenna 3.

Ant4 SV Number Satellites being tracked on antenna 4.

SN Ratio Signal-to-noise ratio for antenna 4.

 Figure 15:  Epoch Counter Window
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Printing

Evaluate allows you to print the active window, all open windows , or an image of the 
entire Ashtech Evaluate screen.  You can use print capability if one of the Ashtech 
windows is open.  

1. To print, select Print.... from the GPS menu.

2. When the Print window opens, mark one of the following radio buttons:

Active window - prints the active window only

All windows - prints each of the opened windows wholly

Screen copy - prints screen copy

3. Select the Print button to start printing, or Cancel button to stop. 

4. If you need to change the printer setup, select Print Setup from the GPS 
menu.  When the dialog box opens, choose the appropriate parameters, 
noting that the Print Setup dialog box is standard for Windows applications. 

5. Because soft copy (screen) colors and hard copy (paper) colors differ, some 
hard copy details may not print correctly and some may not print at all. You 
may need to adjust colors to get meaningful black and white printouts.  For 
example, to print a sky chart, adjust colors in Sky Chart by using the Colors 
tab of Options from the View menu to get clear and distinct details, 
numbers, and titles on your hard copy. 

Logging Files

Evaluate captures output data into a *.LOG file. Evaluate can capture all output up to a 
rate of 5 Hz, however when using output rates faster than 1 Hz, it is important to use 
the highest baud rate your system can support. Low baud rates are not capable of 
capturing large output at a fast update rate.

Evaluate sequentially numbers the log files. A log file will log a maximum of 5000 
epochs. After Evaluate logs 5000 epochs into a file, that file closes and a new file 
opens.

Close all other Windows programs and unnecessary Evaluate screens while logging data.  Failure to 
do so can result in file and data corruption. 

To log a file:

1. Ensure that the receiver is on and computing a position.

2. Select Log from the GPS menu (Figure 16). A check next to Log indicates 
that logging is active. The Epoch counter dialog box (Figure 17) opens 
indicating: 
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• Epoch interval in seconds

• Total epochs logged
• Name of log file
• Total amount of memory used
• Amount of memory available (also in percentage). 

3. Evaluate will log all information from the receiver.  Be sure you have 
configured your receiver to output the desired data.   

4. To end logging, deselect Log from the GPS menu or press F2.

5. The log file is placed automatically in the Log subdirectory of the Evaluate 
directory, filed under the name indicated in the Epoch Counter window. 

 Figure 16:  GPS Pull-down Menu

 Figure 17:  Epoch Counter
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Ending the log file session does not automatically stop the receiver from outputting data.  You must 
turn responses off manually. 

Viewing a Log File

A logfile can be viewed epoch by epoch after it has been logged using Evaluate or any 
text editor. To view a log file using Evaluate:

1. Select Disconnect from the GPS menu or CTRL+D to disconnect the GPS 
receiver.

2. Select View log file from the GPS menu or press F3. The Open window 
opens, Figure 18 (Evaluate displays the last directory used).        

3. Select the file you wish to view. Log files are stored in the Log subdirectory 
of the Evaluate directory.

4. Click OK. 

Evaluate rapidly analyzes the log file and opens the Position Information 
window, the Sky chart window, and the Epoch counter window.  All data 
is displayed when these windows are opened. 

5. Use the Epoch counter window, Figure 19,  to scroll through the log file. 

     

 Figure 18:  Open Window

 Figure 19:  Epoch Counter window
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Click on the “movie” box in the Epoch counter window to see a motion picture of 
log file.   The Position information and Sky chart screens are updated for each 
epoch of the log file. 

6. Exit the viewing mode by deselecting View log file from the GPS menu.

Creating a *.GPS file

If you have a certain set of commands and receiver settings that you apply often 
starting Evaluate, you can put these commands into a .GPS file and have the 
commands activated upon receiver connection.  In this manner, you can always s
with the parameters of your choice. The .GPS file is actually a text file.  As such,
can be created and edited using any ASCII text editor.

Some things to remember when initializing from a file:

• Use $PASHS,RST (reset) first to reset the receiver. 
• If you are logging data, begin with $PASHQ,RID (receiver identification) 

log the receiver and firmware you are using, for future reference.
• Make sure you receive a $PASHR,ACK (acknowledge) or a configuratio

response before going to the next command. All set commands respond
an ACK/NACK;  all query commands respond with a $PASHR message

• Group your commands in logical order (i.e., settings before verification).
• Consider ending with $PASHS,SAV (save) to save your settings.   

You may create a *.GPS file by using the Terminal GPS window. To create the *.GPS 
file:

1. Choose the Terminal  command from the GPS menu.

2. Check the Make check box in the Create *.GPS box. The Create File for 
Initialization GPS window opens (Figure 20).        

 Figure 20:  Create File for Initialization GPS Window
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3. Type the file name in the File name field. You must place the new .GPS file 
in the Receiver subdirectory of the Evaluate directory.  Evaluate looks only 
in this subdirectory for *.GPS files for initialization. 

4. Click OK.

5. The Create File for Initialization GPS window is displayed with the Add 
button accessible in the Create *.GPS box.

6. Select a command from the drop-down list or type one and click Send.

In some cases, the command requires further input such as selecting a 
specific parameter. Be sure you complete this prior to the next step.

7. Once the command has been sent to the receiver, click Add in the Create 
*.GPS box to add this command.

Evaluate asks if you wish to add this command to the *.GPS file. Click Yes.

8. Upon completion of adding all commands necessary to the receiver 
initialization file, close the GPS Receiver Terminal window.

Evaluate always begins connecting to a receiver with a PWR (power) set command, PRT (port) 
query command, and RID (receiver identification) query command.  It then moves to your custom 
.GPS file. 

Using Evaluate for Analysis

Evaluate enables statistical analysis of position precision from a stationary antenna 
(or stationary antenna array for ADU2) in real-time mode and on logged data. You 
can analyze data from log files or view data being taken in real-time and displayed 
using the Analysis format.

1. Select Analysis from the GPS menu. A Warning dialog box (Figure 21)  
opens to remind you that you are connected to a receiver and the antenna 
must be stationary if you are analyzing data in real time.  The box appears 
only if a receiver is connected.  If you want to view logged data, you must 
choose Cancel, then select Disconnect from the GPS menu.  You can then 
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proceed to analyze logged data.  If you choose OK, you will begin viewing 
in real time after you have selected the desired settings in step 2 below.           

2. Click OK to continue or Cancel to return the previous state.

If you click OK, the Static Position Data dialog box opens (Figure 22).  
Choose the desired setting and click OK.  The static position data window 
disappears, awaiting your selection of a log file.  Or, if you are collecting and 
analyzing data in real time, the Position information window automatically 
appears and displays data in the analysis format.

 Figure 21:  Warning Dialog
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3. If you are viewing data from a log file, open log file.

4. The data from the log file displays in Analysis format.  You can now view 
individual points by using the scroll bar or movie box in the Epoch counter 
window described on page 17. (Figure 23).        

When running analysis in real-time, the number of data points displayed on the scatter plot is limited 
by available memory. However, the measurement statistics are not limited by memory and will use 
all data collected up to the current epoch. When running analysis on logged data, all of the data will 
be displayed in the scatter plot.

When running analysis on logged data, the Movie function and epoch scrolling in the Epochs counter 
window do not work as in real-time. Precision measures information in the Position information 
window does not upgrade. The statistics shown once have been done for the whole file, and will not 
change.

Analysis When True Antenna Position is Not Known

If the true position of your antenna is not known:

1. Click Average over time in the Static Position Data box.

2. Enter Ring1 and Ring2 (in the same units you selected under Options) in 
their respective fields if required.

 Figure 22:  Static Position Data Window
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3. Click OK to begin analysis. The Position information window opens 
(Figure 23).       

If analysis is active, the Position information screen changes from Departure Plot and Analog dials to 
a Scatter Plot and Analysis.

The Position information window consists of three sections.

The Scatter Plot section plots the positions relative to the starting point. The starting 
point is a point with coordinates received when the Position information window 
opens. The present position is denoted by a large red cross. 

The units shown on the Scatter Plot are the same as the units chosen for the Departure Plot. To 
increase resolution (useful when analyzing high accuracy RTK positions), use a smaller unit (such as 
centimeter).

 Figure 23:  Position Information Window/No Known Position
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The second section provides precision measurement information. Table 7 describes 
the components of this section.

Table 7: Analysis Information Measurements

Component Description

Horizontal standard deviation A measurement of the dispersion about the mean horizontal 
position. The square of the horizontal standard deviation is given 
by:

(Horizontal standard deviation)2=(North standard deviation)2 + 

(East standard deviation)2

A circle with radius of two horizontal standard deviations 
contains approximately 95% to 98% of the distribution, 
depending on the shape of the distribution (more elliptical => 
closer to 95%, more circular => closer to 98%).

East standard deviation A measure of the dispersion of the positions about the mean 
longitude. If N positions were recorded, then the square of the 

east standard deviation is given by:

North standard deviation A measure of the dispersion of the positions about the mean 
latitude. If N positions were recorded, then the square of the north 

standard deviation is given by:

Vertical standard deviation A measure of the dispersion of the positions about the mean 
altitude. If N positions were recorded, then the square of the 

vertical standard deviation is given by:

An interval within two standard deviations of the mean latitude, 
longitude, or altitude contains approximately 95% of the 
positions.

Mean Latitude The average of the latitude position distributions.

Mean Longitude The average of longitude position distributions.

Mean Altitude The average of the altitude position distributions.
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The third section displays the basic position information for each point as it is 
collected.  This information includes Autonomous/DGPS status, number of SVs used 
in position calculation, UTC time, latitude, longitude, altitude above WGS-84, and all 
DOP readings. 

Analysis When True Position of Antenna is Known

If the true position of your antenna is known:

1. Click vs Truth in the Static Position Data box.

2. Enter the latitude, longitude and altitude in the Known Position box.

Evaluate will not allow you to delete the measurement characters: °, ‘, “. If you highlight these 
characters in the Lat and Lon fields and try to replace them with new values, Evaluate will not allow 
the command. You must highlight each value separately without highlighting the measurement 
character to modify Lat and Lon.

Or

Click Load from GPS Receiver and correct the coordinates in the 
respective fields (if you press the Load from GPS Receiver button, the 
program loads the coordinates from the line of the Position Information 
window).

Heading Standard deviation A measure of the dispersion of the heading about the mean 
heading. If N headings were recorded, then the square of the 

heading standard deviation is given by:

An interval within two standard deviations of the mean contains 
approximately 95% of the headings.

Pitch standard deviation Defined similarly to “Heading Standard deviation”

Roll standard deviation Defined similarly to “Heading Standard deviation”

Mean Heading The average of the heading position distributions.

Mean Pitch The average of the pitch distributions.

Mean Roll The average of the roll distributions.

Mean BRMS The average of BRMS distributions.

Percentage good attitude 
availability

(Number of bad attitude measurements)/Number of epochs

Table 7: Analysis Information Measurements (continued)

Component Description
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The program allows you to set up the format you want to use to enter your true 
position. The default is dd mm.mmmmm (degrees, minutes, decimal minutes). The 
altitude units are meters by default.  If you have changed the units for the Position 
Information window, the units will also be changed for the Analysis function. 

Use the measurement units tab from the OPTIONS... command from the VIEW menu to set up the 
coordinate format and altitude units.

3. Click OK to begin analysis. Then the Position information window opens, 
as shown in Figure 24. 

If analysis is active, the POSITION INFORMATION screen changes from Departure Plot and Analog 
dials to a Scatter Plot and Analysis.

The Position information window consists of three sections.

The Scatter Plot section plots positions relative to the known position. The present 
position is denoted by a large red cross. 

The units shown on the Scatter Plot are the same as the units chosen for the Departure Plot.

 Figure 24:  Position Information Window/Known Position
Evaluate 5.0 User’s Guide



Ashtech Ev

g. If 

d 
The second section provides Precision Measures information. Table 8 describes the 
components of this section.

Table 8: Precision Measurements Information

Component Description

CEP Circular Error Probable. The radius of the circle, centered at the 
known antenna position, that contains 50% of the points in a horizontal 
scatter plot. This is the same as the typical accuracy, since half the 
positions are more accurate than this, half are less accurate.

Horizontal rms The root mean square of horizontal errors.

East rms The root mean square of east errors.

North rms The root mean square of north errors.

Horizontal 95% The radius of the circle, centered at the known antenna position, that 
contains 95% of the points in a horizontal scatter plot.

Vertical rms The root mean square of vertical errors.

Vertical 95% The vertical distance, above and below the known antenna position, 
that contains 95% of the points in a vertical scatter plot.

Mean East error Error between Mean Longitude and Known Longitude, this should 
tend towards zero over time.

Mean North error Error between Mean Latitude and Known Latitude, this should tend 
towards zero over time.

Mean Altitude error Error between Mean Altitude and Known Altitude, this should tend 
towards zero over time.

Outlier limit
• # Outliers
• % Outliers

Defined by user
• Number of positions outside the outlier limit
• Number of outliers expressed as a percent of total points

Mean Latitude The average of latitude position distributions.

Mean Longitude The average of longitude position distributions.

Mean Altitude The average of altitude position distributions.

Heading Standard deviation A measure of the dispersion of the headings about the mean headin
N headings were recorded, then the square of the heading standard 

deviation is given by:

An interval within two standard deviations of the mean contains 
approximately 95% of the headings.

Pitch & Roll standard 
deviations

Defined similarly to “Heading Standard deviation”.

Percentage good attitude 
availability

(Number of bad attitude measurements/(Number of epochs) expresse
as a percentage.
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Below the text in the second section is a pair of histograms showing  horizontal and 
vertical errors. To view these histograms, you may need to scroll down using the 
scroll bar at the right edge of the screen. The Y-axis numbers show the density of 
distribution f(x), defined at point x so that f(x) represents the fraction of positions in 
the interval x to x+dx. Typically, you will have so many samples that these Y-axis 
numbers will be very small (refer to Figure 25). The main benefit of histograms is to 
provide a graphical indication of the distribution. The top plot shows the horizontal 
distribution from the known latitude and longitude. The X-axis shows the radial error, 
R in units selected in the Options menu.The X-axis scales automatically to include all 
positions, so it is a good reference to check the largest outlier in any data set. The 
bottom plot shows the vertical distribution from the known altitude in the same units 
as the top plot. To increase the resolution, select smaller units.        

The third section displays basic position information for each point as it is collected.  
This information includes Autonomous/GPS status, number of SVs used in position 
calculation, UTC time, latitude, longitude, altitude above WGS-84, and all DOP 
readings. 

Horizontal and vertical 
distributions around known 
positions

The horizontal and vertical distributions are represented on the graphs. 
Figure 25 is an example of the graphs.

 Figure 25:  Horizontal and Vertical Distributions

Table 8: Precision Measurements Information (continued)

Component Description
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Almanac

When a receiver is turned on and locks to the first satellite, it receives information 
about the GPS constellation. This information, an “Almanac”, contains data on e
satellite; ID, Health, Eccentricity, and Argument of Perigee to name a few. When
using Evaluate, you can download this information from the receiver to your 
computer. This capability is not available for the Ashtech ADU2.

Perform the following steps to download an Almanac (Ashtech receivers only):

1. Connect a GPS receiver to your computer.

Ensure the receiver has the almanac information stored prior to 
downloading. If tracking satellites for 15 minutes or more, the receiver 
should have a current almanac.

2. Select Download from the Almanac menu.

3. While the receiver is downloading the almanac information to your 
computer, Evaluate displays the following window which indicates the 
status of the download (Figure 26).         

The title of the window includes the amount of information (percentage) 
downloaded to your computer.

Evaluate may complete downloading though indicate a percentage less than 100% done.  This is 
normal operation and should not be considered a malfunciton.  Evaluate bases its percentage of 
completion on the number of satellite slots available vs the number received in the almanac.  Down 
satellites or unused slots will result in a lower percentage of overall completion. 

 Figure 26:  Downloading Almanac Window
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4. As soon as the receiver completes the downloading process, Evaluate 
displays the Satellite almanac window, Figure 27.         

5. You may save this information as file in your computer by performing the 
following steps:

a. With the Satellite almanac window open, select Save As under the 
Almanac menu.

b. Select either Asthech Binary or Yuma ASCII.

c. Evaluate names the almanac files automatically.

6. You may view a previously saved almanac file by selecting Open from the 
Almanac menu.

 Figure 27:  Typical Satellite Almanac Window
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File Types

Evaluate uses several file types:

• *.MNU—Command file for GPS Receiver Terminal and Menu of 
commands 

• *.GPS—GPS receiver initialization file
• *.LOG—Log file
• ALM*.*—Almanac file

MNU File Type

The ASHTECH.MNU file contains the list of commands to send to a GPS receiver b
using the GPS Receiver Terminal or Menu of commands. You can edit or create 
this file with any text editor. The following symbols in the command line give you 
ability to select parameters for each command:

• #—automatically selects the receiver send port
• %N—allows the user to select a numeric value from within a range, with

default
• %L—displays a list of values from which one can be chosen
• %M—displays a list of values from which several can be chosen

The following is an example of a *.MNU FILE:

;Here is place for comments
Reset a receiver to default settings
$PASHS, RST
Set request satellite status message
$PASHS,NME,SAT,#,ON
Turn off NMEA message
$PASHS,NME,%L,#,OFF
Select NMEA message;
GLL,GXP,GGA,VTG,GSN,ALM,MSG,DAL,
GSA,GSV,HDT,TTT,RRE,PAT,GRS,GSS,PO
S, SAT
Enable or disable GPS message type 1 or 9, and 
select period
$PASHS,RTC,TYP,%L,%N
Select message type;1,9
Enter period;0,99,1
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Table 9 describes each line of the example *.MNU file.

GPS File Types

These files contain initialization commands for a GPS receiver (see ADU2 receiver 
initialization example in Table 10). The program supports adu_.gps, g12_.gps, 
gg24.gps, sen2.gps, sca_.gps, g8_.gps.

Table 9: *.MNU Text Descriptions

Text Description

; Here is place for comments You may insert comments in a line starting with a 
semi-colon.

Reset receiver to default settings Menu text. 
You can see this text in the list of commands

$PASHS, RST Command.
You can see this command in the Terminal GPS 
window, after you press Send button.

Set request satellite status message Menu text. 

$PASHS,NME,SAT,#,ON Command
The program determines the port automatically and 
sets specific port in place of #.

Turn off NMEA message Menu text.

$PASHS,NME,%L,#,OFF Command with two parameters: %L, #.

Select NMEA messages; 
GLL,GXP,GGA,VTG,GSN,ALM,MSG,DAL,
GSA,GSV,HDT,TTT,RRE,PAT,GRS,GSS,PO
S, SAT

Prompt to select, followed by a “;”, followed by the 
list of parameter values (values should be delimited 
with comma).

Enable or disable GPS message type 1 or 9, and 
select period

Menu text

$PASHS,RTC,TYP,%L,%N Command with two parameters: %L, %N.

Select message type;1,9

Enter period;0,99,1

Prompt to select, followed by a “;”, followed by the 
list of parameter values
Prompt to enter, followed by a “;”, followed by the 
range of parameter values (in this example 0—
minimum, 99—maximum, 1—default)

*      TITLE If a line starts with “*” this line appears in the 
Terminal GPS window, but cannot be selected.
This text is used to provide a heading within the 
menu.
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Evaluate also provides *.GPS files to help you initialize Differential or RTK Base Stations or 

Remotes. Before using the files “DIFF_BAS.GPS” or “ ZRTK_BAS.GPS”, edit the file to enter the 
correct base station position.

You can create files or use the *.GPS files included with Ashtech Evaluate (refer to 
“Creating a *.GPS file” on page 21). You can edit the *.GPS file with any standard 
text editor. Consult your receiver user manual to determine the functions and op
for your receiver.       

Log File Types

These files are created by Ashtech Evaluate, if you turn on the Log mode. They are 
stored automatically in the LOG directory. The name for the *.log file is the recei
type and its number, for example:

sen2_001.log

where sen2 is the receiver type (Sensor II) and 001 is the log session number.

Almanac File Types

These files are created by Evaluate if the Save As command has been implemented.
Evaluate stores these files in the almanacs subdirectory of the Evaluate directory. 
The names of Ashtech binary and Yuma ASCII files differ. Both file types contain
year and day of year in the file name:

Table 10: GPS File Descriptions

adu_.gps Description

/Relative position vector from
/antenna 1 to antenna 2; X,Y,Z in meters

$PASHS,3DF,V12,+1.173,-0.033,+0.014

/antenna 1 to antenna 3
$PASHS,3DF,V13,+1.221,+1.379,+0.012
/antenna 1 to antenna 4
$PASHS,3DF,V14,-0.000,+1.407,+0.026

• User comment added to *.gps file with 
text editor after it was created. Note the 
“/” added to the beginning of comment 
line. This is done so Evaluate will 
ignore line during receiver 
initialization.

• Actual command with parameters 
added to initialization file from 
Evaluate.

• See first bullet above.
• See second bullet above.
• See first bullet above.
• See second bullet above.
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Typical Ashtech file name:    

alm96.123

where 96 is the year and 123 is the day number. 

Typical Yuma file name:       

almy96.123 

where 96 is the year and 123 is the day number

Menu Overview and Shortcut Keys

Figure 28 displays the main menu of the Ashtech Evaluate program. 

Table 11 describes each menu item with associated shortcut key

 Figure 28:  Main Menu

Table 11: Shortcut Key Menu

Option Description Shortcut Key/Button

GPS Drop down menu N/A

• Connect... Opens the Connection Parameters dialog box to 
connect a GPS receiver

Ctrl+G, 

• Disconnect Disconnects a GPS receiver Ctrl+D

• Send... Sends command to a GPS receiver Ctrl+S, 

• Terminal... Opens the Terminal GPS window to 
communicate with a GPS receiver

Ctrl+T, 

• Log... Logs receiver responses into a file F2, 

• View log file... Opens a *.log file. F3, 
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• Analysis Active Opens the Static Position Data dialog box to 
define parameters for analysis of position 
precision

• Emulation Turns on/off the Emulation mode N/A

• Print Prints active window, all windows, or an entire 
screen copy

Ctrl+P  

• Print setup Sets the printer and the page format N/A

• Exit Ends Evaluate session N/A

Almanac Drop down Menu N/A

• Download Sets the GPS receiver to almanac transmitting N/A

• Open Opens the File Open dialog box to view the 
existing almanac file.

N/A

• Save As Saves almanac file in one of two formats: 
Ashtech Binary or Yuma ASCII.

N/A

View Drop down menu N/A

• Position Opens the Position information window Shift+P, 

• Sky Chart Opens the Sky chart window Shift+S, 

• Epoch Counter Opens the Epochs counter window Shift+E, 

• Ashtech receiver 
information

Provides a picture and brief description of the 
product. 

• Generic NMEA 
receiver information

Provides information on connecting to non-
Ashtech receivers that support standard NMEA 
interface.

• Port Activity Displays information on connection between  
GPS receiver and computer.

Shift+A

• Options... Opens the Option dialog box with three tabs: 
General, Measurement Units, and Colors

N/A

• Toolbar Displays/hides the Toolbar N/A

• Status Bar Displays/hides the Status Bar N/A

Window Drop down menu N/A

Table 11: Shortcut Key Menu (continued)

Option Description Shortcut Key/Button
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Table 12 describes the shortcut keys available when the Position Information 
window is active:

Table 13 describes the shortcut keys available when the Epochs counter window is 
active.

• Cascade Resizes the open group windows so that each 
title bar is visible 

N/A

• Tile Horizontal Arranges windows on top of each other so that 
they do not overlap 

N/A

• Tile Vertical Arranges windows side by side so that they do 
not overlap 

N/A

• Arrange Icons Arranges windows reduced to icons N/A

Help Drop down menu N/A

• Index Displays a comprehensive index to information 
contained in the Help system 

N/A

• Using Help Teaches how to use Help N/A

About Ashtech Evaluate... Displays information about Ashtech Evaluate N/A

Table 12: Position Information Shortcut Keys 

Shortcut Key Function

Home Decreases the scale of circles in the same 
proportions as the End key.

End Increase the scale of the circles: .5, 5, 10, 20, 50 
and up doubles in size.

Table 13: Epochs Counter Shortcut Keys 

Shortcut Key Function

Left Arrow To scroll 1 epoch to back

Right Arrow To scroll 1 epoch to forward

Page Up To scroll 10 epochs to back

Page Down To scroll 10 epochs to forward

Table 11: Shortcut Key Menu (continued)

Option Description Shortcut Key/Button
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Evaluate allows you to select specific settings for the program such as color and 
measurement units. To access optional settings, select Options from the pull-down 
menu under View. 

General

To select general settings of Evaluate, select General within the Options menu, 
Figure 29.    Table 14 describes the settings within this window.     

 Figure 29:  General Settings Window

Table 14: General Settings window 

Component Description

Course Dial Up Setting which direction is 
pointing up: 

• North Up
• Head/COG Up

Sky Chart Layout Setting which indicates 
view of Sky Chart:

• Horizontal
• Vertical

Devices Feature Settings which indicates 
style of instruments

• Automobile
• Aeronautical
• Nautical
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Head/COG Up—When the receiver is an ADU (Altitude Determination Unit), the actual heading of 
the vehicle is known and the course dial will display Head Up. When the receiver is other than an 
ADU, the actual heading of the vehicle is not known and the course dial will display COG (course 
over ground) Up.

Measurements Units

To define measurement units and coordinate formats, select Measurement Units 
window, Figure 30, under the Options menu. The program displays units on the 
Status bar.  

These parameters allow Evaluate to convert measurement units.  They are not changing the setting
in the receiver or changing precision in any way.            

Logging directory Allows you to specify 
different logging 
directory.

Display startup menu on 
startup

Determines if startup 
menu is displayed once 
Evaluate is started.

 Figure 30:  Measurement Units Window

Table 14: General Settings window  (continued)

Component Description
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The following units are available in the Evaluate program:

Colors

To select display colors of the Sky Chart and Departure Plot of the Position 
information window, select Colors (Figure 31) within the Options menu.

 Color changes are especially useful when displaying information on a black and white screen. 
Evaluate allows changes in the contrast for better visibility.

        

Table 15: Measurement Units window

Value Unit

Distance nautical mile, mile, kilometer, cable, meter, feet, inches, 
centimeter

Horizontal Speed knot, mph, km/h, m/s, ft/s

Vertical Speed knot, mph, km/h, m/s, ft/s

Altitude meter, feet

Coordinates format
• ddd.dddddddddd
• ddd mm.mmmmmmm
• ddd mm ss.ssssss

• Degrees and fractions of degrees
• Degrees, minutes, and fractions of minutes
• Degrees, minutes, seconds, and fractions of seconds

 Figure 31:  Colors Window
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 Table 16 describes the components of this window. 

    

Connecting to a non-Ashtech Receiver Using a 
Generic NMEA Interface

Evaluate will connect to any GPS receiver that supports the standard NMEA 
messages GGA, GSA, GSV, and VTG. Evaluate also works with receivers that 
support any subset of these four NMEA messages. Evaluate will play back any ASCII 
data file with these NMEA messages, or any subset of these messages.

Connecting to Receiver

 Evaluate will automatically connect to Ashtech receivers, and automatically turn on 
the Ashtech POS and SAT messages when the Position information and Sky chart  
windows are opened. Evaluate can set the baud rate and protocol automatically for 
Ashtech receivers. For non-Ashtech receivers you must do the following:

1. Set the correct communications port, baud rate, and protocol. 

2. Select Manual Connect in the Connection Parameters window. 

3. Set up the receiver to transmit GGA, GSA, GSV and VTG (or as many of 
these as possible). Refer to “Sending Commands to the GPS Receiver” on 
page 9.

4. From the GPS Receiver Terminal window verify that you are receiving the
NMEA messages. 

5. Open the Position information and Sky chart windows to view data as 
described previously.

Table 16: Available Colors Window 

Component Description

Departure Plot The following components of the Departure Plot 
can change color: Background, plot, axes, titles, 
outlier ring, trace, and current position

Sky Chart The following components of the Sky Chart can 
change color: Background, sky, elevation rings, 
satellites, satellites PRN, forward track, and 
backward track

Set new color... Allows you to select a different color for the 
selected window component. Choose from a preset 
list or define a custom color.

Restore all defaults Restores all color setting to factory defaults.
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Initialize from File 

Only Ashtech receivers can initialize from a *.GPS file.  

Logging Data 

Evaluate will log data from any receiver. For Ashtech receivers the reserved 
filenames are used. For non-Ashtech receivers the file names are: UNKN_xxx.LOG, 
where xxx denotes numbers from 001 through 999.  Refer to “Logging Files” on 
page 18.

Viewing Logged Data 

To play back data from a file, open the data file; Refer to “Viewing a Log File” on
page 20. Evaluate reserves certain file names for Ashtech receivers. For these f
Evaluate looks for Ashtech POS and SAT messages. For any other file named *.L
Evaluate looks for the four NMEA messages GGA, GSA, GSV, VTG. Reserved 
Ashtech filenames are: 

ADU2_xxx.LOG SCA_xxx.LOG

G8___xxx.LOG SII_xxx.LOG

G12__xxx.LOG Z12__xxx.LOG

GG24_xxx.LOG 

Almanac Download

Evaluate will download almanacs from Ashtech receivers only (excluding the 
ADU2).

Analysis 

The Analysis feature works with any receiver supporting the GGA message.  Ref
“Using Evaluate for Analysis” on page 22.

Heading, Pitch, Roll, and Yaw 

These dials work with Ashtech ADU2 only. Note that COG (Course over Ground
different from Heading. COG works with any Ashtech receiver, and any receiver
supporting VTG. 
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